
 
 

VERSION 6.3.0.3903 RELEASE NOTES 

 

CHEMCAD New Features and Enhancements 

• Added the capability to specify a chemical reaction enhancement factor for mass transfer distillation calculations (2842)  

• Added an auto-estimation mode for the Batch Distillation Column UnitOp to improve column convergence (2896)  

• Enhanced distillation curve characterization to use the standard stream selection dialog box (516)  

• Added a warning for a one-sided heat exchanger so that users will know if utility rating entries are overriding Specifications tab entries (1151)  

• Added the Browse capability to assist in finding a targeted Excel Data Map (1567/2772)  

• Enhanced the Composite Curves feature to make shifting composite curves optional (2763)  

• Enhanced stream properties to allow entropy to have units of absolute temperature (°R, K) (2808)  

• Added the capability to rename an Excel Data Map while it is open in CHEMCAD (2852)  

• Enhanced the RAMP UnitOp so that it no longer generates errors when disabled (2878)  

 

CHEMCAD Maintenance 

• Corrected an issue where a Stream Reference UnitOp in bypass mode could trigger a ‘No specifications' error message (1959)  

• Corrected an issue with the Predictive Crystallizer example simulation so that the Excel UnitOp runs properly (2547)  

• Corrected an issue where CHEMCAD could close unexpectedly if left open and idle for long periods of time (2819)  

• Corrected an issue where imported user electrolyte components were not recognized as electrolytes (2860)  

• Corrected an issue where the Control Valve UnitOp in ‘Fix flow and position' mode could recalculate the flow rate instead of pressure (2863)  

CC-THERM 

• Changed the default nozzle sizes in CC-THERM to standard pipe sizes (2845)  

• Corrected an issue where deleting Excel Data Map rows could cause difficulties with the Data Map (2855)  

• Improved the default inlet and outlet baffle spacing for new CC-THERM simulations (2857)  

• Corrected an issue where a heat exchanger in fouling rating mode, with two or more parallel shells, could generate different service and calculated heat 

transfer coefficients (2886)  

• Added the LMTD correction factor to air cooler reports (1479)  

• Added Stream Analysis for segmental baffles with no tubes in window (2518)  

• Added Window, End, and Crossing velocities to the tabulated report for baffles with no tubes in window (2523)  

• Corrected an issue with fouling values being assigned to the wrong side of an air cooler for an air-side fouling rating (2662)  

• Disabled certain calculated fields when the Heat Exchanger UnitOp is in simulation mode, as these values are not relevant in that mode (2804)  

• Corrected an issue where CC-THERM reported inconsistent values for density on the TEMA report in MS Word or the internal report viewer (2815)  

• Corrected an issue where creating a TEMA sheet could cause CHEMCAD to close unexpectedly (2818)  

• Corrected an issue where a pinch warning appeared when the number of shells in series was greater than 1 for a Heat Exchanger UnitOp in simulation mode 

(2838)  



 
 

VERSION 6.2.2.3728 RELEASE NOTES 

 

CHEMCAD New Features and Enhancements 

• Added the capability to use COM objects to control instances of CHEMCAD (591/2512)  

• Added the Browse capability to assist in finding a targeted Excel DataMap (1567/2772)  

• Added the capability to perform a data reconciliation from the xlCHEMCAD menu in Excel (1991)  

• Added the capability install CHEMCAD silently (2092)  

• Added the Format > Starting IDs command, which enables the user to set starting ID ranges for streams and UnitOps (2157)  

• Added a comment field for Excel DataMap (2469)  

• Added the capability to copy and paste values within a DataMap (2486)  

• Added the capability to store BIPs in a database other than NRTL, Wilson, SRK, PR, or BWRS (2602)  

• Improved the performance of local thermodynamic settings (2634)  

• Added the capability to shift hot and cold composite curves to achieve minimum delta T (2635)  

• Added the capability to load a simulation into Excel as read-only from the xlCHEMCAD menu (2638)  

• Added new carbon capture examples to CHEMCAD installation (2673)  

• Enhanced the vessel pressure graph for a dynamic run by adding a y-axis title (2691)  

CHEMCAD Maintenance 

• Corrected an issue, introduced with version 6.2.1, which could cause flash errors in systems with dissolved supercritical gases in water (2761)  

• Corrected an issue that occurred when a user specified 0 °C or 0 °F for a TPXY plot based on constant temperature (1064)  

• Corrected an issue with stream or UnitOp groups not updating ID numbers (1078)  

• Corrected an issue with improperly displayed plots and reports via Terminal Server (2103)  

• Corrected a data entry issue in the crude oil database (2237)  

• Corrected an issue with the xlCHEMCAD menu in Excel not initializing for Vista users (2471/2485)  

• Corrected an issue with fouling values being assigned to the wrong side of an air cooler for an air-side fouling rating (2662)  

• Corrected an issue where initial vessel pressure and liquid pressure could be inconsistent when static pressure was specified (2744)  

• Corrected an issue where CHEMCAD simulations could fail to save when opened from and saved back to a USB drive (2778) 

 Removed redundant items from the View > Flowsheet Settings submenu (2812)  

• Corrected an issue where subcooled liquid could improperly flash (only occurred in test versions) (2867)  

CC-THERM 

• Removed improper baffle cut restrictions on double and triple segmental baffles (2316)  

• Corrected an issue with the reporting of generic turbulator data in Excel (2378)  

• Corrected an issue where the wrong condensing type was reported for the VDI method (2475)  

• Corrected an issue with the fouling ratings mode for air coolers (2657)  

• Corrected an issue with co-current and vertical knock-back condensers displaying incorrect inlet vapor velocity (2697)  

• Corrected an issue where a double-pipe simulation with a user-specified fin tube did not converge (2711)  

• Corrected an issue with air cooler heat curve editing (2755)  

• Added an error message that displays when no liquid is present in a kettle reboiler (2779)  

• Corrected an issue where the General Specifications dialog box sometimes failed to appear when needed for a kettle reboiler (2780)  



 
 

VERSION 6.2.1.3597 RELEASE NOTES 

CHEMCAD New Features and Enhancements 

• Added the LMTD correction factor to air cooler reports (1479)  

• Added new 'read-only' LoadSim() function to COM API (1988)  

• Added the Pikes Peak Selexol simulation to the CHEMCAD examples (2196)  

• Added the capability to set legacy CHEMCAD 5 settings from the Options menu (2296)  

• Added the capability to use the BWRS thermodynamic method in CHEMCAD 6 (2331)  

• Added the capability to show/hide all stream names in a simulation (2350)  

• Created a new recycle cut stream algorithm to take controllers into account (2497)  

• Added the Ideal Cp/Cv property for Data Map and VBA (2517)  

• Added Stream Analysis for segmental baffles with no tubes in window (2518)  

• Added Window, End, and Crossing velocities to the tabulated report for baffles with no tubes in window (2523)  

• Added the capability to regress electrolyte BIPs between inert solvents and ions (2541)  

• Added an option for a Composite Curve delta T plot (2555)  

• Added a Notes section to the Consolidated Report (2559)  

• Added a new print format for electrolyte regression (2567)  

• Changed the interaction between CHEMCAD and Microsoft Word due to MS security changes (2621)  

• Added five new CHEMCAD examples for power plant carbon capture (2673)  

• Added the TmmC term to the electrolyte NRTL model (2709)  

CHEMCAD Maintenance 

• Corrected the equation for the LMTD correction factor for 4-4 air coolers (2491)  

• Corrected an issue with the toolbar Restore Default command (2514)  

• Corrected an issue with the Controller UnitOp's Scale labels (2516)  

• Corrected an issue where LLV unit icons created with Symbol Builder were added to the Flash subpalette (2540)  

• Corrected an issue with nested controller loops and recycle loops in sequential mode (2551)  

• Corrected an issue where CHEMCAD could give a false message when a local thermodynamics method is specified (2568)  

• Corrected an issue where a new BIP stored in a simulation could be listed as a system BIP (2603)  

CC-THERM 

• Corrected an error with display units for shell-side and tube-side film resistances on CC-THERM reports (2318)  

• Corrected an issue with the Vertical Thermosyphon not accepting the optional h film coefficient value (2515)  

• Corrected an issue where the Reynolds number was not reported when using double-or triple-segmental baffle with Bell-Delaware method (2565)  

• Corrected an issue where running an air cooler case on a Tower Plus unit could reset simulation settings (2584)  

• Corrected an issue with thermosyphon heat curve convergence (2598)  

• Corrected an issue with random text displaying for utility streams in the air cooler stream report (2619)  



 
CC-DYNAMICS 

• Added the option to reset integral error for the PID controller and control valve UnitOps (1231)  

• Added a warning to display if the PID controller set point value is not within bounds of Variable Min and Variable Max (2033)  

• Added rate regression simulations to the Dynamics examples directory (2227)  

• Corrected an issue where the "Save As" command did not properly save the initial state for dynamic simulations (2501)  

• Added the capability to use packed column rating pressure profile in dynamic simulations (2536)  

• Corrected an issue where the runtime plot for CC-DYNAMICS could stop and prevent other plots from displaying under Windows Vista and 7 (2730)  

VERSION 6.2.0 RELEASE NOTES 
 
CHEMCAD New Features and Enhancements 

• Introduced the CHEMCAD Report Writer system, which provides enhanced user-customizable reports (2006)  

• Added the capability to enter user-created BIPs into a database (1525)  

• Added the capability to generate equilateral triangular plots (870)  

• Added the capability to omit unconverged points from a TPXY plot (2223)  

• Added the capability to optimize OPC performance by selectively limiting the data published via OPC (2224)  

• Improved System Authorization licensing method to apply to a specific computer rather than to individual users (2210)  

• Added new examples covering Selexol(TM) carbon capture, reaction rate regression, and multiple-effect evaporation (2196, 2227, 2532)  

• Added a thermal conductivity mixing rule for electrolytes (682)  

• Added the capability for OPC users to change feed stream component flow rates, temperature, pressure, velocity, and total flow (800)  

• Created the Mass and Energy Balances report, which replaces the Convergence report (855)  

• Added distillation curves D86 and TPB to the available options on the Stream Properties report (912)  

• Revised and made available packing data for Billet and Schultes method (1330)  

• Added the window velocity value to the Zone-By-Zone Analysis for shell-side sensible flow and tube-side condensation or evaporation (1516)  

• Added a multiple-inlet symbol to the Gibbs Reactor sub-palette (1577)  

• Added the capability to model solid-vapor equilibrium (1710)  

• Added the capability to edit the PID Controller calculated results on the Misc Settings tab (2032)  

• Created a warning that displays if the PID controller setpoint value falls outside the sensor's defined range (2033)  

• Made the Mass Transfer report easier to read (2078)  

• Changed the name of the Stream Recorder History plot to Stream History (2085)  

• Added a prompt enabling the user to specify where to store user-defined components for a single component database (2101)  

• Added UNIFAC subgroups for component 2027, Pentaethylene Hexamine (2164)  

• Added the capability to include up to 50 different solid components in a single simulation (2193)  

• Added the capability to specify up to six objects for feed-forward controllers (2240)  

• Added the capability to reset the UnitOp palette to display the original default icons (2253)  

• Added a warning message to inform user of incorrect formula entered for user-added component (2282)  

• Added the capability to set the CHEMCAD 5 import directories from within CHEMCAD 6 (2296)  

• Changed the Topology report to include the calculation sequence (2308)  

• Improved mass transfer column convergence (2369)  

• Improved the TBP/D86 conversion method (2382)  

• Added the capability to change heat exchanger simulation mode from a DataMap or controller (2467)  

• Added mass balance view for dynamic simulations (2478)  

• Added ITAE calculation to the PID controller UnitOp (2482)  



 
 

CHEMCAD Maintenance 

• Improved flash convergence for electrolytes in adiabatic flash (2438)  

• Corrected an issue with the TPXY plot (PSRK/latent heat, Acetylene/Hexane) producing one out-of-place point (831)  

• Corrected an issue with the behavior of items on the Other Data component editing dialog box (953)  

• Removed a message about CAPE-OPEN thermodynamics from the Errors and Warnings tab when not applicable (1125)  

• Corrected a rare issue with reactive distillation in SCDS not working properly on top of a batch reactor (1216)  

• Corrected an issue with META unit improperly calculating stream flow rates between parent and child simulations (1543)  

• Corrected an issue with VBA that could occur when the CHEMCAD interface was not running (1728)  

• Corrected an issue that sometimes caused unzipped CHEMCAD files to have incorrect file creation dates (1973)  

• Corrected an issue where user-created components could fail to copy properly as part of a stream copy operation (2202)  

• Corrected an issue with the DataMap feature not working properly in simulations containing both SCDS and batch reactor UnitOps (2212)  

• Corrected an issue where the use of local K-values for a distillation column could prevent a simulation from being saved (2247)  

• Corrected an issue where standard liquid volume was reported incorrectly in the Stream Properties report for electrolytes (2290)  

• Corrected an issue that prevented the addition of a user icon to the PID Controller sub-palette (2298)  

• Corrected an issue with the total flow rate on the Bulk Properties page of pseudocomponent curves failing to match the flowsheet for certain flow units 

 (2303)  

• Corrected an issue with cut stream persisting after a second cut stream is selected (2305)  

• Corrected an issue with calculation of air cooler tube-side pressure drop (2322)  

• Corrected an issue with UnitOp dialog boxes performing input checks on calculated values (2332)  

• Corrected an issue with Batch Reactor T/Q specifications not saving properly when zero reactions are specified (2348)  

• Corrected an issue with user-specified cut streams failing to save correctly (2351)  

• Corrected an issue where the OPC server functioned improperly when run as a COM server without the CHEMCAD graphical user interface (2364)  

• Corrected an issue where the liquid phase was deleted from the Solid Components dialog box after changes were made to the flowsheet (2371)  

• Corrected various formatting and content issues in Excel reports (2417, 2421, 2423)  

• Corrected an issue that caused the Sensitivity Study dialog box to behave incorrectly for ten or more recorded variables (2437)  

• Corrected an issue with the WAR report that caused extraneous characters to print with user component names (2456)  

• Corrected an issue with electrolyte reactions being unavailable when first created (2462)  

• Corrected an issue that prevented reaction constant changes made during a dynamic run from affecting that run's results (2490)  

• Corrected an issue that prevented the Save As command from correctly saving the initial state for a dynamic simulation (2501)  

• Corrected a dialog box issue to allow entry of liquid-liquid extractor side product specifications (2506)  

• Corrected an issue that caused CHEMCAD, in rare situations, to stall after a user edited a stream and then ran the simulation (2508)  

CC-THERM 

• Improved vibration analysis by using actual inlet/outlet baffle spacing for cross-flow velocity (1523)  

• Added a ‘No Baffle' option in the CC-THERM Baffle Specifications dialog box (1353)  

• Added the capability to enter a negative value for the air-side inlet temperature for air coolers (1981)  

• Corrected an issue where baffle spacing was incorrectly affecting the calculation for X shell in a sensible-sensible case (2066)  

• Corrected a rare issue with calculation of vapor phase fraction for the vibration report (2236)  

• Corrected an issue with CC-THERM failing to save heat curve edits (2245)  

• Corrected an issue with incorrect units displaying for shell-side and tube-side film resistances on CC-THERM reports (2318)  

• Corrected an issue with heating curves not initializing correctly (2374)  

 


